
Post	Processing	SIG	-	July	2016	
	

• What's	New	in	Lightroom	and	Photoshop	-	Pete	Poulsen	
	

• How	to	Make	a	Preset	for	Your	Workflow	-	Richard	Houghton	
	

• Nik	Silver	Efex	Pro	2	
o Overview	-	Mac	Rodgers	
o Example	Workflow	#1	-	Mike	Schaffner	
o Example	Workflow	#2	-	Beth	Goetzman	

	
• Batch	Processing	in	the	Nik	Collection	

	
• Nik	Sharpener	Pro	-	Don	Rueter	

	



What’s	New	in	
Lightroom	&	Photoshop?			

Pete	Poulsen	



	
New	Transform	Panel	in	Develop	

•  Lightroom	CC	2015.6	(June	2016)	
•  New	Transform	Panel	in	Develop		
(Spun	off	from	Lens	Correc6on	panel)	

•  MulHple	ways	to	correct	distorted	photos	
•  New	Guided	Upright	tool	
–  	Draw	up	to	four	lines		
–  Aligned	with	horizontal	or	verHcal	axis	(2	each)	

Lightroom	CC	



	
Transform	Panel	Tools	

•  Level:	Corrects	horizontal	distorHons	
•  Ver6cal:	Corrects	verHcal	distorHons	
•  Auto:	Corrects	both	verHcal	and	horizonta.	
•  Full:	CombinaHon	of	full	Level,	VerHcal,	

and	Auto	perspecHve	correcHons	
•  Guided:	Allows	you	to	draw	two	or	more	guides	on	your	

photo	to	customize	perspecHve	correcHon	
•  Sliders:	Use	Scale	to	show	“lost”	areas	
•  Constrain	Crop:	AutomaHcally	crop	out	lost	edges	
•  Upright:	Can	be	copied	(Copy	SeUngs)	or	synchronized	

(Sync	SeUngs),	for	use	on	one	or	more	photographs.	

Lightroom	CC	



	
Boundary	Warp		
(merged	panoramas)	

•  Lightroom	CC	2015.4/Lightroom	6.4	
•  Intelligently	warps	the	panorama	boundaries	to	
remove	areas	of	transparency	and	lost	edges	

•  Can	use	Boundary	Warp	together	with	the	Auto	Crop	

Lightroom	CC	



Content	Aware	Crop	
•  Photoshop	CC	2015.5	(June	2015)	
•  Intelligently	fill	in	gaps	when	using	Crop	tool		
– RotaHng	or	straightening	image	
– Expanding	canvas	beyond	image's	original	size	

Photoshop	CC	
	
	



	
Other	Tools	

(To	be	covered	in	August	PP	SIG)	

Face-Aware	Liquify	
•  AutomaHcally	idenHfy	eyes,	noses,	mouths,	etc.	
•  Retouching	portrait	photos,	creaHng	caricatures,	etc.	
	
Select	and	Mask	Workspace	
•  Quicker	and	easier	selecHons	and	masks	
	

Photoshop	CC	



How to Make a Preset for Your Workflow in 
Lightroom. 
 
1. Start on any un-edited image and make your most common adjustments in all the tabs that you 
normally use. If you do not have an established workflow: 
**Recommend the following:** 

BASIC Tab 
Highlights  -100 
Shadows    +100 
Clarity        +15 
Vibrance     +15 
Lens Corrections Tab 
Tick both boxes 
 

2. Then to create the User Profile, Click the “+” near the Presets tab on the left side of Lightroom. 
Give the new Preset a name like: “Starting Adjustments”, then on the lower left, “Check All”, 
then say “Create”.  Now you can just make all these adjustment in the future by clicking once on 
your new preset when you have a picture open in the Develop Module.  
 
A better plan is to add your new Preset to the “Apply During Import” when you import new 
files into Lightroom. This way, all your files are partially edited as you import them. But you are 
not through yet.. 

 
**Important Final Adjustment in Your Preset Workflow** Your first adjustment after using 
the Preset is to set the white point and black point. You cannot do this in the Preset because the 
photos are all too different from each other.  To set these, Under the BASIC Tab, hold down the 
shift key and double-click Whites and then Blacks. That’s it. You are done with your initial 
adjustments. 
 
If you need to modify or add other adjustments to your preset,  

1. apply the preset as usual to any un-edited image. 
2. Make your changes 
3. Right-click on your preset in the left panel and choose “Update With Current Settings” 

 
==================================================================== 
 

Instant Color Correction  in Photoshop 
 
When you have an image that has an unpleasant tint such as the orange you get when taking a 
photo indoors without flash, there is a very quick fix. Do the following: 
 

1. Open Image In Photoshop 
On the top menu, click Image > Adjustments > Match Color > tick the “neutralize” box 
2. That’s it!  Continue with your workflow as normal. 

 
 
 
Contributed by Richard Houghton  



Nik Silver Efex Pro 2
Monochrome Processing

Buffet Style and Cook-It-Yourself

1

Mac Rodgers 
July 2016

SEP2 Highlights
• Unique Algorithms - Advancements in black and white controls 

help you achieve great results quickly. Take advantage of tools 
like Dynamic Brightness, Soft Contrast, Amplify Whites, Amplify 
Blacks, and the advanced Grain Engine. 

• All-in-one Tool Set - Emulate nearly 20 popular film types, add 
finishing adjustments like toners and borders, and tune your 
image to produce superior black-and-white results. Silver Efex 
Pro gives you control over the entire process. 

• More Freedom to Edit - Try different looks, compare different 
edited states of your image, and undo adjustments at any time 
-- all thanks to Silver Efex Pro’s built-in History Browser.
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SEP2 Features
• 38 Built-in Presets using advanced global tonality adjustments, color 

filters, film types, levels & curves, and finishing adjustments 

• Global tonality sliders to customize overall brightness, contrast and 
structure 

• Control points provide selective control over brightness, contrast and 
structure 

• Global and selective adjustments have advanced features for more 
control 

• Film type parameters include grain, spectral sensitivity, and tone curve 

• Finishing adjustments include color toning, vignetting, edge burn and 
image borders

3

SEP2 User Interface
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SEP2 Workflow with Control Points 
Starting from Lightroom

1. In LR, do basic processing as desired. Don’t convert to 
B&W. 

2. Choose Photo-Edit in..-Silver Efex Pro 2, which automatically 
converts image to monochrome - Neutral Preset. 

3. Select a preset that approaches the style you desire. 

4. If satisfied, select SAVE which will save a TIFF or JPEG file 
to the same LR folder as your original. 

5. If more adjustments are needed, consider COLOR FILTER 
first, then GLOBAL ADJUSTMENT

5

SEP2 Workflow with Control Points 
Starting from Lightroom

6. Place CONTROL POINTS where you want localized effects 
(brightness, contrast or structure); adjust control point size; don’t 
forget the advanced sliders.  

7. Check the effect of control points by viewing the mask check box to 
the right of each added control point. 

8. Add “guard” control points where you want to decrease the effect of 
surrounding control points. 

9. Apply filters and finishing effects.* 

10. If desired, save preset using “Custom” tab on left (control points will 
not be saved). 

11. Select “Save” at lower right to save results as a TIFF file.

* Filters and finishing effects described next.
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SEP2 
Filters, Films and Finishing

• Filters 

‣ Preset filters to lighten or darken based on original image colors 

‣ Sliders for custom hue and intensity 

• Film Types 

‣ 18 different B&W film profiles simulating grain, spectral 
sensitivity, and tonal curve 

‣ Customizable 

• Finishing adjustments - Toning, vignette, edge burn and borders

7

SEP2 
Starting from Photoshop

• With image open in Photoshop, choose Filter - Nik 
Collection - Silver Efex Pro. 

• Work in SEP2 as before, and select OK (bottom 
right)  - This will alter the image permanently. 

• OR, select BRUSH (bottom right), which will 
create a new layer with a layer mask. The new 
layer is the SEP2 B&W image. You can “paint in” 
and/or conceal portions of the SEP image, make 
adjustments with layer opacity or blend mode.
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Nik Silver Efex Pro 2 
Training Resources

• Google Nik Collection Site: https://
www.google.com/nikcollection/products/silver-
efex-pro/ 

• Ed Gregory on SEP2: https://www.youtube.com/
watch?v=5kKf1e6YRjM 

• Anthony Morganti on SEP2: http://
www.anthonymorganti.com/tag/silver-efex-pro-2/
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Using	Nik	Silver	Efex	Pro	2	for	Black	and	White	Photos	
Mike	Schaffner	July,	2016	

	
Described	below	is	the	general	workflow	I	use	to	process	black	and	white	photos.		It	works	well	for	me	
and	produces	a	type	of	photo	I	like.		There	are	many	ways	to	process	photos	and	everyone	has	their	own	
preference	in	terms	of	process	and	desired	outcome.		Use	this	as	one	method	and	adjust	as	you	feel	to	
meet	your	preferences.	

	
1. Preparing	the	photo	(Lightroom)	

• Adjust	the	white	balance	if	necessary	
• Set	you	white	and	black	points	
• Clean	up	dust	spot	etc.	
• Adjust	the	highlight	slider	if	there	are	any	hot	spots	that	may	draw	your	eye	away	from	the	main	

subject		(you	can	re-adjust	later	if	needed)	
• Adjust	the	Shadows	slider	to	lighten	up	any	dark	areas.		If	you	tend	towards	low	key	processing	

as	I	do	this	will	tend	to	make	these	areas	darker	(you	can	re-adjust	later	if	needed)	
• Do	not	adjust	contrast,	saturation,	clarity,	vibrance,	luminance	or	sharpen	the	photo	
• Export	the	photo	to	Nik	Sharpener	Pro	3:	Raw	Presharpener	
• Export	to	Photoshop	

	
2. Adjusting	color	in	Photoshop	(Photoshop	or	possibly	Lightroom)	
Gavin	Hardcastle	is	a	photographer	specializing	in	color	landscapes	and	produces	really	beautiful	photos.		
He	also	leads	workshops	and	sells	Lightroom	presets,	e-books	etc.		He	also	has	a	Photoshop	action	that	
is	 free	 (if	 you	 like	his	website	 on	 Facebook,	 or	 Twitter	 or	Google+).	 	 I	 tried	 this	 on	 a	 photo	 and	 then	
happened	to	take	it	to	black	and	white	and	I	liked	how	it	worked	as	a	prep	stage.		The	action	basically	
adjusts:	

• Sharpens	the	photo	
• Adjusts	the	shadow/highlights		
• Increases	the	vibrance	

It	seems	that	this	helps	to	give	more	color	separation/differentiation	when	in	black	and	white.		You	can	
get	the	free	action	at:	https://www.fototripper.com/download-free-photoshop-actions/				
	
If	you	don’t	have	Photoshop	you	might	try	making	Lightroom	adjustments	to	sharpen/contrast/vibrance	
but	I	don’t	have	any	setting	suggestions.	
	
3. Processing	in	Silver	Efex	Pro	2.	

• Load	 your	 photo	 into	 Silver	 Efex	 Pro	 and	 select	 a	 preset	 that	 comes	 closest	 to	 your	 desired	
outcome.		These	are	only	a	starting	point.		The	ones	I	tend	to	use	the	most	are:	

o 009	Low	Key	1	
o 010	Low	Key	2	
o 023	Wet	Rocks	

Take	a	look	at	all	and	use	the	one	that	best	meets	your	needs.	
	



At	this	point	 turn	your	attention	to	the	column	on	the	right.	 	You’ll	 find	sliders	 for	brightness,	
contrast,	 structure	along	with	 finishing	 choices	and	control	points.	 	 Information	on	 the	use	of	
control	points	can	be	found	here:	https://www.youtube.com/watch?v=Y7ylUUaMvg8	.			
	
Strange	as	it	may	sound	perhaps	the	most	significant	factor	in	black	and	white	digital	photos	is	
color.		Lightroom	and	Silver	Efex	make	color	adjustments	in	different	ways	for	black	and	white.	

o In	 LR	 when	 you	 convert	 a	 photo	 to	 B&W	 you	 are	 presented	 with	 a	 number	 of	 color	
sliders.		Adjusting	a	single	slider	adjusts	that	color	only	in	the	underlying	color	image	and	
converts	 it	 to	 greyscale.	 	 	 Thus	 in	 a	 typical	 landscape	 with	 a	 blue	 sky	 and	 green	
vegetation	converted	to	B&W	in	LR:	

§ Sliding	the	red	slider	has	no	effect	(assuming	no	red	in	the	original	photo)	
§ Sliding	the	blue	slider	lightens/darkens	the	sky	only	
§ Sliding	the	green	slider	lightens/darkens	the	vegetation	only	

o Silver	Efex	uses	 color	 filter	 that	work	 the	 same	way	as	 the	color	 filters	we	used	when	
shooting	 B&W	 film	 (pre-DSLR	 days).	 	 The	 filters	 work	 on	 the	 reflected	 light	 and	 let	
through	 or	 block	 colors	 based	 on	 their	 position	 on	 the	 color	 spectrum	 relative	 to	 the	
color	 of	 the	 selected	 filter	 (see	 http://www.freestylephoto.biz/black-and-white-filters-
tutorial	for	a	more	in	depth	explanation).		Thus	in	a	typical	landscape	with	a	blue	sky	and	
green	vegetation	converted	to	B&W	in	Silver	Efex:	

§ Selecting	the	red	filter	will	darken	the	sky	and	darken	the	vegetation	
§ Selecting	the	blue	filter	lightens	the	sky	but	darkens	the	vegetation	
§ Selecting	the	green	filter	lightens	the	vegetation	and	lightens	the	sky	slightly	

Clearly,	adjusting	color	 in	Silver	Efex	 is	a	bit	more	complicated	but	 if	you	keep	in	mind	
the	 relationships	 of	 color	 you	 can	 adjust	 it	 well	 using	 the	 color	 filters	 and	 the	 film	
sensitivity	sliders	(located	in	the	“Film	Types”	section	immediately	below	the	color	filtes	
section).	
	
Typically	I	like	to	darken	the	sky	and	lighten	the	vegetation	which	can	be	accomplished	
in	two	ways:	

§ Use	 a	 green	 filter	 to	 lighten	 the	 vegetation	 and	 slide	 the	 blue	 film	 sensitivity	
slider	to	the	left	to	darken	the	sky,	or	

§ Use	 a	 red	 filter	 to	 darken	 the	 sky	 and	 slide	 the	 green	 and/or	 yellow	 film	
sensitivity	slider	to	the	right	

If	using	these	the	color	filter	in	combination	with	the	film	color	sensitivity	slider	doesn’t	
get	you	where	you	want	to	go	you	may	have	to	start	over	in	LR	or	PS	and	lighten/darken	
to	get	it	closer	to	the	tone	you	are	looking	for	and	then	fine-tune	it	in	Silver	Efex.	

	
4. Cleanup	in	Photoshop	

Once	you’re	done	in	Silver	Efex	there	is	some	cleanup	needed	to	be	done	in	PS	for	halos,	dust,	and	
sharpening	
	
Halos	

	 Haloing	is	a	common	occurrence	when	doing	low	key	B&W	conversions	(you’ll	see	it	with	HDR	
sometimes	too).		It	is	often	caused	when	you	reduce	the	contrast	ration	(brightness/darkness).		



Halos	will	appear	as	a	white	glow	around	objects	 like	trees,	buildings,	mountains	etc.	 	Trees	in	
particular	can	look	like	very	unusual.		Some	examples	of	haloing	are	below:	

	

	
	

	
	

Fortunately,	there	is	an	easy	fix	using	the	Healing	Brush	Tool	(not	to	be	confused	with	the	Spot	
Healing	 Brush	 tool)	 in	 Photoshop.	 	 This	 video	 outlines	 the	 process	
https://www.youtube.com/watch?v=wcOZcwHdqz8.	 	 Unfortunately	 I	 don’t	 know	 of	 a	 way	 to	
remove	halos	if	you	only	have	Lightroom	and	not	Photoshop.	



	
Spots	

Even	though	you	may	have	cleaned	up	dust	spots	etc.	 in	the	 initial	steps	you	may	notice	even	
more	after	B&W	processing	especially	in	low	key	processing	so	it	is	good	to	re-check.	

	
Sharpening	

You	can	do	noise	reduction	at	this	point	using	Nik	Dfine.			
	

5. Finishing	steps	(Lightroom)	
I	finish	the	photo	by	increasing	clarity,	sharpening	the	photo	and	applying	a	post-crop	vignette.		The	
settings	I	use	are	listed	below	but	you	can	use	whatever	looks	best	to	you.	

o Increase	clarity	in	the	range	of	+40	to	+60	
o Sharpen	in	the	range	of	40	to	50	
o Post-crop	vignette	in	the	range	of	-20	to	-40.	

	
	
	
	
	
	
	
	
	
	
	
	
	

	
	



Nik Silver Efex Pro 2
Beth Goetzman

Woodlands Camera Club SIG

July 18, 2016



Workflow

Very little needs to be done to the original RAW 
file.  







� Bring down the highlights

� Bring up the shadows

� Add just a bit of clarity

Basic 
Menu



�Sharpen / Sharpen 
Mask
�General rule for sharpen 

masking is 100 –
luminance = amount of 
sharpening

�Hold down alt key and 
move masking until the 
part of the photo you 
don’t want sharpened is 
black and it will not be 
sharpened.  Hard edges 
will be sharp and the sky 
and water will not be.

� Add small amount of 
luminance, it’s a black & 
white photo so there will be 
noise by the time you’re 
finished with it anyway.

Detail Menu



� Remove Chromatic 
Aberration

� Enable Profile Corrections

Lens Corrections 
Menu



Used to automatically straighten photo

Transform Menu

� Click Auto and

� Constrain Crop



�Optional –Color Profile

Camera Calibration Menu



� To move to Silver EFX

� Right click on photo

� Edit in

� Silver EFX Pro

Nik Silver EFX Pro 2 workflow

� Wait for LM or Photoshop to convert to TIF and open Silver EFX 
Pro

� I have several favorite pre-sets that I have tagged.  If I don’t like 
them as a starting point I just play with the photo.  

� Global adjustments affect the entire photo.  You can use these 
to bring up the structure, brightness and contrast of the entire 
photo

� Add control points to specific areas that you want to enhance 
(tone down structure for sky, water, reflections, etc.

� Color filters reference the original colors in the photos.  
Red is warmest, blue is coolest



Nik Silver EFX Pro 2 workflow 
(con’t)

� Under film types, you can change to a specific type or 
just add grain or smooth it out.  More grains per pixel 
will smooth it out, less grains will enhance or make it 
grungier.

� Toning, burning edges, vignette and Image borders

� (vignette and burning edges have the same effect in 
blacks)

� Once you’re happy with your photo click save and the 
program will take you back into your host program –
Lightroom for me.



Converted TIF File (before any 

modifications)



After Edits in Silver EFX 
Pro 2



Last Steps

� Make any additional small changes 
through your host software, Photoshop, 
Lightroom, etc.

� Adjust exposure, crop/straighten, etc.



















Batch Processing in the Nik Collection Through Photoshop 
 
https://support.google.com/nikcollection/answer/3000837?hl=en&ref_topic=2991
631 
 
Creating an Action for the Batch Process 
1 Open an image in Photoshop. 
2 Open the Actions tab by clicking on Window > Actions. 
3 Click  just to the left of the trash can icon at the bottom on the Actions 

tab in Photoshop, and assign a name for your action. 
4 Click  on the Actions tab to begin recording your action. 
5 Duplicate the image layer in the Layers palette, and ensure the new layer 

is selected. 
6 Edit the image inside Sharpener Pro 3. 
7 Click  on the Actions tab. Your Action is now complete, and can be 

viewed in the Actions tab. 
Performing the Batch Process 
1 Create a new folder on your desktop labeled with the action name and 

the word "Processed" such as "Output Sharpener Processed." This 
folder will contain all of the images once the action has been applied 
to them. 

2 In Photoshop, navigate to the File > Automate menu and select Batch. 
3 Ensure that the action that was created earlier is indicated in the Action 

pull-down menu. If the correct action is not indicated, click on the 
pull-down menu and select the correct action. 

4 Under source, indicate folder, and then click Choose. Navigate to the 
folder that contains all of the images that you want to apply the 
Batch Process to. 

5 Under Destination, select Folder. Click Choose and navigate to the folder 
that was created on your desktop earlier. For example, navigate to 
the "Output Sharpener Processed" folder. 

6 Click OK. 
The Batch Process will now begin and apply the filter from the Action to all 
of the images in the folder, and save a new copy of the image with the filter 
applied to the folder that was created on the desktop. 



Nik Collection 
Sharpener Pro 3 



Sharpener Pro 3 
Highlights 

•  Enhance subtle details and textures to create images in a 
distinctive style. The Structure, Local Contrast, and Focus 
tools give you a variety of creative sharpening options. 

•  Selectively apply improvements using control points to help 
your viewers focus on the right areas. Enhancements blend 
into your image for a natural final result. 

•  Create perfectly sharpened images customized for display, 
inkjet, continuous tone, half tone, hybrid print devices, and 
more. The Output Sharpener helps you mitigate loss of detail 
caused by different output methods. 

•  Two separate tools: 
–  RAW Presharpener 
–  Output Sharpener 



Sharpener Pro 3 
RAW Presharpener 

•  Misnamed – Cannot sharpen RAW image 
•  First tool to be applied before making other adjustments 
•  Similar to sharpening in Lightroom with more control 
•  Global Sharpening 
•  Selective Sharpening 

–  Control Points 
–  Color Range 

•  Be careful not to sharpen noise – harder to remove later 



Sharpener Pro 3 
Output Sharpener 

•  Sharpens based on destination (display, printer) 
•  Resize image to actual display or print size before using 

Output Sharpener for best results 
•  Selective Sharpening 

–  Control Points 
–  Color Range 

•  Creative Sharpening – separate from output sharpening 
–  Structure – Texture; Brings out fine details 
–  Local Contrast – Adds contrast to each object; Separates 

objects from each other 
–  Focus – Similar to high pass sharpening; Lightens/Darkens 

individual pixels to increase contrast at pixel level 
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